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In This Guide
Agilent has prepared this manual as a technical reference for the Oligo Pro II data 
analysis software for use with the Oligo Pro II parallel capillary electrophoresis 
system.

This document is intended for use by technical personnel that are proficient with 
analytical instrumentation operation. A certain level of training and expertise is 
assumed and fundamentals are not addressed herein. Information is presented in 
a section-by-section format using screen captures and written descriptions. If 
questions remain after reviewing a given topic, please contact your corresponding 
Agilent Sales/Service Representative.

1 Oligo Pro II Data Analysis System Overview 

This chapter gives an overview of the Oligo Pro II data analysis software.

2 Oligo Pro II System Requirements and Installation 

This chapter provides information on the requirements and installation 
instructions for the Oligo Pro II data analysis software. 

3 Oligo Pro II Data Analysis – Main Screen 

This chapter provides an overview of the Oligo Pro II data analysis software main 
screen.

4 Oligo Pro II Data Analysis Software – Settings Menu 

This chapter provides an overview of the settings menu, which is available on the 
main screen of the Oligo Pro II data analysis software.

5 Oligo PRO II Data Analysis Software – Overlay Samples 

This chapter provides an overview of the possible ways to compare samples in the 
Oligo PRO II data analysis software.

6 Oligo Pro II Data Analysis – View Capillary Positions 

This chapter briefly covers the tools and functions of the View Capillary Positions 
window.
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7 Exporting Data from the Oligo Pro II Data Analysis Software 

This chapter provides an overview of the options available for exporting processed 
data from the Oligo Pro II data analysis software.

8 Generating Reports from the Oligo Pro II Data Analysis Software 

This chapter provides an overview of the options available for generating reports 
from the Oligo Pro II data analysis software.
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1 Oligo Pro II Data Analysis System Overview

About the System 7
Oligo Pro II System 7
Oligo Pro II Data Analysis Software 7

This chapter gives an overview of the Oligo Pro II data analysis software.



1 Oligo Pro II Data Analysis System Overview
About the System

Oligo Pro II Data Analysis Software User Manual 7

About the System

Oligo Pro II System

The Oligo Pro II system is an UV absorbance-based DNA/RNA oligomer analysis 
system for determining the purity of nucleic acid oligomers. 

Dedicated Oligo Pro II instrument software is provided for system operation and 
data collection, employing a simple user interface for programming experiments 
from one to as many as three 96-well sample plates.

Oligo Pro II Data Analysis Software

Agilent’s Oligo Pro II data analysis software is designed for analyzing the raw 
data from the Oligo Pro II instrument and reporting the purity of oligomers. The 
Oligo Pro II data analysis software performs the following general functions:
• Reads the raw data files generated from the Oligo Pro II instrument 

operational software.
• Provides quantitative measurements of DNA/RNA oligomer purity present in a 

sample.
• Exports purity data as well as raw Electropherogram trace data (time vs. 

absorbance) and digital Electropherogram traces in .jpg, .bmp or .png image 
formats.

• Generates PDF format sample reports containing user specified information.

This manual serves as a guide to the Oligo Pro II data analysis software and will 
assist the user in taking advantage of the many benefits of the Oligo Pro II 
system.
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2 Oligo Pro II System Requirements and 
Installation

System Requirements 9
General Software Requirements 9
Operating System 9
PC Recommendation 10

Oligo Pro II Data Analysis Software Installation Instructions 11

This chapter provides information on the requirements and installation 
instructions for the Oligo Pro II data analysis software.
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System Requirements

General Software Requirements

Report Review

A PDF viewer is required to read Adobe PDF formatted reports. 

Install the most recent version of Adobe Reader. The software is available free of 
charge for download at www.adobe.com.

Data File Export

• The Oligo Pro II data analysis software exports data in a generic 
comma-separated values (.csv) file format, which can be read by most 
spreadsheet and database management programs. Install a spreadsheet 
program (for example, Excel, OpenOffice) to open and read exported .csv files.

• Electropherogram images are exported in a .jpg, .bmp, or .png image format. 
A suitable program for viewing these file formats should be installed.

Operating System

The Oligo Pro II data analysis software must be installed on a computer running a 
Windows operating system to function properly. 

Table 1 Supported operating systems

Operating System Details

Windows Windows 10, 32-bit or 64-bit
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PC Recommendation

The table provides the recommended hardware configuration for the Oligo Pro II 
data analysis software.

Table 2 Recommended hardware configuration

Item Details

Processor speed (CPU) Intel Core 2, or faster

Physical memory (RAM) 4 GB

Hard disk 500 GB (for accommodation of raw data files)

Graphic resolution 1280 x 800 minimum screen resolution 
1280 x 1024 recommended



2 Oligo Pro II System Requirements and Installation
Oligo Pro II Data Analysis Software Installation Instructions

Oligo Pro II Data Analysis Software User Manual 11

Oligo Pro II Data Analysis Software Installation 
Instructions

To Install the Software

1 Download the appropriate installer from the Agilent website.
2 Run the installer and follow the instructions and prompts provided by the 

installation wizard.
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3 Oligo Pro II Data Analysis – Main Screen

Main Screen (No Data File Open) 13
Opening a Data File in the Oligo Pro II Data Analysis Software 15

Main Screen (Data File Open) 17
Electropherogram Trace Toolbar Menu 21
Electropherogram Trace Context Menu 24
Peak Table 26
Sample Name Table 27

This chapter provides an overview of the Oligo Pro II data analysis software main 
screen.
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Main Screen (No Data File Open) 

The functions and menu items available from the main screen of the Oligo Pro II 
data analysis software prior to opening a *.raw data file are summarized in 
Table 3.

Figure 1 Main Menu screen of Oligo Pro II data analysis software (no data file open)

Table 3 Main menu screen menu items (active with no data file open)

Menu Option Description

File

Open File Opens a file browser dialog for locating and opening 
a raw data file (*.raw extension) generated by the 
Oligo Pro II instrument control software, for 
subsequent data analysis.

Recent Files Displays up to the last 10 data file locations opened 
in the Oligo Pro II data analysis software. 

Exit Closes the Oligo Pro II data analysis software. 
When closing, the data file, all settings and 
operations are automatically saved.
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Project

Load Project Opens a file browser dialog for locating and opening 
a Project data file (*.proj extension) generated by 
the Oligo Pro II data analysis software. For further 
information on creation of project data files, see 
Chapter 5, “Oligo PRO II Data Analysis Software – 
Overlay Samples”.

New Project Allows you to open the Project screen and create a 
project by selecting different *.raw data files. 

Tools

Options Allows you to set default file path, language, 
capillary data format (row or column), and default 
peak analysis parameters.

Help

User Manual Displays User manuals associated with the 
Oligo Pro II data analysis software.

About Displays software information, version information, 
copyright information and Agilent technical support 
contact information.

Table 3 Main menu screen menu items (active with no data file open)

Menu Option Description
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Opening a Data File in the Oligo Pro II Data Analysis 
Software

To Open a Data File

1 From the main menu, select File > Open File (alternatively, select  from the 
toolbar). 

A file browser opens (Figure 2).

Figure 2 Main Menu screen of Oligo Pro II data analysis software (data file open)

2 Navigate to your raw data file (*.raw extension) generated by the Oligo Pro II 
instrument control software.
• To set a file location as default location: In the file browser, right-click either 

the folder or select the arrow , and from the menu, select Set as Default 
Path.

• To go to a default location: In the file browser, select one of the four default 
paths on the left side.
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3 Select the .raw file (Figure 3).

Figure 3 Data selection
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Main Screen (Data File Open) 

Once a data file is opened in the Oligo Pro II data analysis software, several 
additional functions are enabled as summarized in Table 4. The opened data is 
displayed in the main screen as shown in Figure 4.

Table 4 Additional Main Menu screen menu items (active only with data file open)

Menu Option Description

Icons

Generate PDF Opens a menu for configuring and generating a .pdf report, containing 
user specified information (electropherograms, gel images, peak 
information, etc.). For more information, see Chapter 8, “Generating 
Reports from the Oligo Pro II Data Analysis Software”.

Export Files Opens a menu for configuring and exporting User specified data to a 
user specified folder. Types of data include gel images, 
electropherograms, peak tables, etc. For more information, see 
Chapter 7, “Exporting Data from the Oligo Pro II Data Analysis 
Software”.

Purity Table Allows you to generate a Purity Analysis table.

Analysis

Quick View Displays the Quick View window, which shows non-normalized 
electropherograms for all 12 capillaries (or windows of 12-capillaries 
each for a 96-capillary array format) enabling quick review of the data.

View Capillary Positions Opens the View Capillary Positions screen, which allows you to view 
and modify the alignment of the detector signal with the capillary 
positions. For more information, see Chapter 6, “Oligo Pro II Data 
Analysis – View Capillary Positions”.
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Display Separation Parameters Opens the Display Separation Parameters window, which allows you 
to view the current, voltage, and back pressure that occurred during the 
separation.

Project

Create Project Allows you to create a new project for overlaying data files (it uses the 
existing file for project creation).

Help

Zip Open Data File Allows you to ZIP currently opened data file. This is used primarily in 
preparing data files to send to Agilent in cases where troubleshooting 
is required.

Table 4 Additional Main Menu screen menu items (active only with data file open)

Menu Option Description
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Figure 4 Main menu screen of Oligo Pro II data analysis software (96-capillary data file open)

The primary accessible functions from the main screen are shown in Figure 4, 
and are summarized in the legend table: 

1

4
2

5

6

9

3

7 8

1 Main screen toolbar
2 Electropherogram 

trace
An Electropherogram trace of the currently selected well. The well position and sample name (if 
imported) is displayed in the upper left corner of the trace. Use the Electropherogram trace toolbar 
and context menu to process or annotate the data (Table 5 and Table 6).

3 Plate map Shows the currently selected well highlighted in green (A1 is the default location on opening the file). 
Click on the appropriate well by using the keyboard arrows. You can select any well of the plate for 
individual viewing.

4 Sample name table Displays the sample names as entered into the instrument software, or imported after post-run. 
Enables you to navigate to the samples (Figure 9). A brief summary is given in section “Sample 
Name Table” on page 27.

5 Info Click to access experimental information regarding the method used to collect the data file 
(Figure 5).

6 Peak table Displays information about the selected and integrated sample peaks (see also Figure 8). For more 
information, refer to section “Peak Table” on page 26.

7 Settings tabs Configuration settings, for which most settings can be individually adjusted for each sample as 
desired. For more detailed information, refer to Chapter 4, “Oligo Pro II Data Analysis Software – 
Settings Menu”.

8 Apply settings Applies configuration settings individually to a selected sample, or to all samples.
9 Filename Upon opening a data file, the currently selected filename/directory is displayed in the lower left 

toolbar.
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Figure 5 Experimental information (method summary) window
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Electropherogram Trace Toolbar Menu 

The options available in the Electropherogram trace toolbar are summarized in 
Table 5. 

Figure 6 Electropherogram trace and toolbar menu

Table 5 Electropherogram trace toolbar functions

Toolbar Option Description

Zoom Enables zooming in the x- and y-axis of the Electropherogram trace. 
To zoom-in: Place the mouse over the trace, click and drag it outward 
to expand a box area to define the zoom region. Release the mouse 
button to apply. The zoomed image can be copied to the clipboard. 
The zoom region will be preserved when viewing other samples in the 
Plate map. To undo the zoom, use the AutoFit function.

Drag Enables panning of the image. Move the image around with the 
mouse cursor, while holding the left mouse key.

AutoFit To autoscale the Electropherogram trace x-/y-axis display.

Copy Copies an image of the current view of the Electropherogram trace to 
the clipboard, for pasting in another program such as Microsoft 
PowerPoint. Any zoom, annotation, baseline and/or peak start/end 
point displayed will be copied in the image. The well ID and sample 
name will be copied in the top left of the trace, and the x-/y-axis will 
correspond to the currently selected view in the copied image
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Units Displays a menu for changing the peak annotation of the 
Electropherogram trace. Only integrated peaks are annotated. 
Units for peak annotation:
• None
• Peak ID (labels in order as 1, 2, etc.)
• Migration Time (min:sec): Raw migration time
• Peak Height (in mAUs)
• Corrected Peak Area (Peak Area/Migration Time)

Create Annotation To create customized annotation in the Electropherogram trace 
display. In the Add Annotation dialog, the user can type desired 
annotation into the field. Click OK and the annotation will be displayed 
in the Electropherogram trace.

To move the annotation to the desired location on the trace: Click the 
annotation and drag it to the desired position. An arrow will appear at 
the opposite end of the annotation upon dragging. The arrow and/or 
annotation can be repositioned by selecting, holding and dragging the 
mouse.
Multiple annotations can be created by repeatedly selecting Create 
Annotation. Any created annotations will be copied to the clipboard 
with the Copy function.

Table 5 Electropherogram trace toolbar functions

Toolbar Option Description
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Edit Annotations Opens the Annotation Editor window. Allows you to:
• Edit the Annotation text by typing in the text field
• Change the color of the annotation by selecting the annotation 

color
• Delete one or all annotations by selecting Delete next to each 

annotation, or selecting Delete All.

Select Apply to confirm your settings.

Show/Hide Baseline Toggle to display and hide the baseline drawn for peak integration, 
shown as an orange line. Displaying the baseline helps if adjustments 
need to be made to the baseline to better define the actual peak area 
via the Peak Width (sec), Valley to Valley, or Manual Baseline 
Setpoints tools.
Note: It is highly recommended to enable the display of the baseline, 
to ensure the correct baseline is being drawn to the data.

Show Peak Start/End Edge Toggle to display or hide the start and end points used for peak 
integration, shown as vertical orange lines.
Displaying the peak integration start/end points helps if adjustments 
need to be made to the peak integration to better define the actual 
peak area. The user can change the peak start/end points by 
adjusting the Peak Width (sec), or by using the context menu tools in 
the Electropherogram trace, such as Split Peak or Move Peak 
Start/End Points (see Table 5). 
The user can change the baseline drawn (and subsequently the peak 
start/end points) via the Peak Width (sec), Valley to Valley, or 
Manual Baseline Setpoints tools.
Note: It is highly recommended to enable the display of the baseline, 
to ensure the correct integration is being drawn to each peak.

Table 5 Electropherogram trace toolbar functions

Toolbar Option Description
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Electropherogram Trace Context Menu 

The context menu of the Electropherogram trace, the y-axis, and the x-axis 
contains functions for adjusting peak assignment, peak integration, and scaling 
the x-axis (Figure 7). Functions are also provided for copying the trace and 
exporting the data, and are summarized in Table 6. 

Figure 7 Main screen zoomed to the Electropherogram trace with context menu displayed

Table 6 Electropherogram trace context menu functions

Menu Option Description

Accept Change Accepts any manual modification to the performed peak integration 
(Add Peak, Split Peak, Merge Peaks, Delete Peak, Move Peak Start/End 
Points). After the manual modification has been made, select Accept 
Change to apply the changes to the trace. 

Cancel Cancels any manual modification to the peak integration (Add Peak, 
Split Peak, Merge Peaks, Delete Peak, Move Peak Start/End Points). 
Select Cancel to discard the changes applied to the trace.

Undo To undo any manual modification applied to the peak integration (Add 
Peak, Split Peak, Merge Peaks, Delete Peak, Move Peak Start/End 
Points). Select Undo to revert back one step.
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Add peak To manually add a peak which has not been auto-integrated by the Peak 
Analysis settings, and to define the start and end point for integration. 
Zoom-in to the region where the peak is to be added. Right-click this 
region, and select Add Peak. Two red vertical cursors will appear; the left 
cursor defines the new peak start point and the right cursor the new peak 
end point. Drag each cursor to the desired position, then right-click, and 
select Accept Change to add the peak for integration.

Split peak To manually split a peak which is currently integrated into two peaks, and 
to define where the split occurs. 
Zoom-in to the region where the peak is to be split. Right-click this region, 
and select Split Peak. A red vertical cursor will appear. Drag the cursor to 
the desired location, then right-click, and select Accept Change to split 
the peak into two peaks for integration.

Merge peaks To merge any number of peaks and integrate as a single peak.
Zoom-in to the region where the peak is to be split. Right-click this region, 
and select Merge Peaks. Two red vertical cursors will appear; the left 
cursor defines the left most peak to merge and right cursor defines the 
right most peak to merge. Drag the cursor within that peak’s start/end 
point region to merge, then right click, and select Accept Change to 
merge the peaks into a single peak for integration.

Delete peak To manually delete a peak which has been integrated. 
Zoom-in to the region where the peak is to be deleted. Right-click this 
region, and select Delete Peak. A red vertical cursor will appear. Drag the 
cursor to the desired peak location, then right-click, and select Accept 
Change to delete the peak from the integration.

Move peak start/end points To change the currently positioned start/end integration points of a peak.
Zoom-in to the region where the peak is located. Place the cursor 
between the start and end points of the integration. Right-click and select 
Move Peak Start/End Points. Two red vertical cursors will appear at the 
current start/end points. Drag the cursors to the desired locations, then 
right-click, and select Accept Change to apply the new start/end point 
positions to reintegrate the peak.
Note: This function will not change the baseline; only the start and end 
points are affected. To change the baseline, the user must adjust the via 
the Peak Width (sec), Valley to Valley, or Manual Baseline Setpoints 
tools.

Copy image to clipboard Copies an image of the current view of the Electropherogram trace to the 
clipboard, for pasting in another program, such as Microsoft PowerPoint. 
Any zoom, annotation, baseline and/or peak start/end point displayed 
will be copied in the image. The well ID and sample name will be copied 
in the top left of the trace, and the x-/y-axis will correspond to the 
currently selected view in the copied image.

Table 6 Electropherogram trace context menu functions

Menu Option Description
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Peak Table 

The Peak Table displays information about the selected and integrated sample 
peaks (Figure 8). The data in this table can be directly exported via its context 
menu. The fields of the Peak Table are summarized in Table 7.

Figure 8 Peak Table form on main screen

Table 7 Peak Table functions

Item Description

Migration time Reports the migration time of the peak (in mm:ss).

Peak height Reports the peak height, in milli absorbance units (mAU).

Corrected peak area Reports the corrected peak area.

Percent purity Reports the percent purity of the peak as a percentage of the total 
integrated peak area.

Export data to clipboard Click in the peak table, and select this option from the context menu.
Exports the peak table information to the clipboard for pasting directly 
into common spreadsheet programs such as Microsoft Excel. The full 
table is exported.
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Sample Name Table 

The Sample name table displays the well location and sample name for each 
sample. 

To Import Sample Names

• When queuing samples in the Oligo Pro II instrument control software
• Post-run by selecting the Import function from the context menu of the 

sample name table (Figure 9): 
• Import .txt files: Depending on the number of samples, enter the names of 

the individual samples in the file in the order 1–12, 1–24, or 1–96
• Import .csv files: Depending on the number of samples, enter the names of 

the individual samples in the file in the column A1, A2, A3, etc. from 1–12, 
1–24, or 1–96

To Export Sample Names

Export the currently entered sample names to a .csv file via the context menu. 
Right-click on the Sample name table, and select Export (Figure 9).

Figure 9 Sample name table form on main screen with context menu displayed
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4 Oligo Pro II Data Analysis Software – Settings 
Menu

About the Settings Menu 29
Peak Analysis Settings 30
Inclusion Region Settings 32
Manual Baseline Settings 33
Electropherogram Start/End Settings 34
Advanced Settings 35
Apply Settings 36

This chapter provides an overview of the settings menu, which is available on the 
main screen of the Oligo Pro II data analysis software.
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About the Settings Menu

Use the settings menu of the main screen (Figure 10) to specify settings for 
processing the data file, including:
• Define peak width and peak height thresholds for peak integration
• Define how the baseline is drawn between peaks
• Define how and to what extent the raw data is filtered
• Define the Inclusion Region whereby peaks are to be integrated and analyzed
• Set a Manual Baseline between defined start and end points
• Enable or disable the Purity Table and establish Flag Level % for scoring purity 

results
• Define the viewable start and end points of each Electropherogram trace

Figure 10 Settings menu (Peak Analysis tab shown)
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Peak Analysis Settings

On the Peak Analysis tab, you can assign width and height thresholds for peak 
selection and integration (Figure 10). The settings are described in Table 8. 

Table 8 Peak analysis settings

Menu Item Description

Peak Analysis

Peak detection window (sec) Defines the width threshold for peak detection in seconds. Higher values 
are better suited for wide peak start/end points; smaller values are better 
suited for sharp peak start/end points.
For sharp peaks, typical values range from 3–5.

Minimum peak height (mAU) Defines the minimum peak height threshold to select a peak for 
integration in mAUs. Peaks below the set value will not be selected for 
integration.
Typical values for this setting are 0.2–1.0 mAU. 

Number extra valley points This setting influences the start/end point of baseline integration of 
peaks and the baseline drawn between peaks. This setting most affects 
the baseline between two peaks that are not baseline resolved. Higher 
values draw a straighter baseline between the first peak start point and 
second peak end point; lower values draw the baseline more to the 
“valley” between the two unresolved peaks.
Note: To use this setting, you must enable Valley to valley baseline? 
setting.
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Valley to valley baseline? This setting influences the start/end point of baseline integration of 
peaks and the baseline drawn between peaks. This setting most affects 
the baseline between two peaks that are not baseline resolved. 
Disable to draw a straighter baseline between the first peak start point 
and second peak end point:

Enable to draw the baseline more to the “valley” between the two 
unresolved peaks:

Filter parameters

Filter Applies a Binomial, Wavelets De-Noising, or no filter to the data.

Number of points Defines the number of points to use in the selected data filter.

Table 8 Peak analysis settings

Menu Item Description
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Inclusion Region Settings

On the Inclusion Region tab, you can set the start and end time in minutes at 
which you want to integrate and analyze the respective electropherogram 
(Figure 11). The settings of the tab are described in Table 9. 

Figure 11 Settings menu (Inclusion Region tab shown)

Table 9 Inclusion region settings

Menu item Description

Start time (min) Defines the start time in minutes at which you want to integrate and analyze 
the electropherogram data. 
Note: If 0 is entered, data are analyzed from start of the electropherogram at 
0 min.

End time (min) Defines the end time in minutes at which you want to integrate and analyze 
the electropherogram data. 
Note: If 0 is entered, data are automatically analyzed to the full time range of 
the electropherogram. 
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Manual Baseline Settings

On the Manual Baseline tab, you can set the start and end time in minutes at 
which you want to start drawing the baseline (Figure 12). The settings of the tab 
are described in Table 10.

Figure 12 Settings menu (Manual Baseline tab shown)

Table 10 Manual Baseline settings

Menu item Description

Start (min) Defines the start time in minutes at which you want to start drawing the 
baseline. 
Note: If start and end points are set to 0, no manual baseline will be displayed. 

End (min) Defines the end time in minutes at which you want to end the baseline 
integration.
Note: If start and end points are set to 0, no manual baseline will be displayed.
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Electropherogram Start/End Settings

On the Electropherogram Start/End tab, you can define the region of the 
respective electropherogram to be displayed (Figure 13). The settings of the tab 
are described in Table 11. 

Figure 13 Settings menu (Electropherogram Start/End tab shown)

Table 11 Electropherogram Start/End settings

Menu item Description

Start time (min) Defines the start time in minutes to be displayed for the electropherogram.
Note: If 0 is entered, the electropherogram starts at 0 min.

End time (min) Defines the end time in minutes to be displayed for the electropherogram.
Note: The default setting is to show the entire run time.
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Advanced Settings 

On the Advanced Settings tab, you can define the display of the Purity table, Flag 
Level %, and the scaling to the inclusion region (Figure 14). The settings are 
described in Table 12.

Figure 14 Settings menu (Advanced Settings tab shown)

Table 12 Advanced settings

Menu item Description

Show purity pass/fail Shows a green or red well in the sample plate indicating a pass or fail 
percent purity status for the data, respectively. 

Flag level percent Determines the minimum percent purity value, which is used as the 
threshold for assigning the pass level for the purity analysis.

Scale to inclusion region Scales the electropherogram to the largest peak in the defined inclusion 
region (you must define an inclusion region on the Inclusion Region tab).
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Apply Settings

With exception of the Advanced Settings tab, you can apply the settings of the 
settings menu either to all capillaries or to selected capillaries (Figure 10, 
Figure 11, Figure 12, and Figure 13). For a description of the given Apply options, 
see Table 13. 

Table 13 Apply settings

Menu item Description

Apply to all Applies the respective settings to all capillaries.

Apply to selected Applies the settings to only the selected capillaries. 
Select this option, and a separate selection window appears that allows you 
to select the capillaries. 
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5 Oligo PRO II Data Analysis Software – Overlay 
Samples

Overlay Options 38
Overlay Samples in the Main Screen 38
Overlay Samples in the Project Overlay Screen 39

This chapter provides an overview of the possible ways to compare samples in 
the Oligo PRO II data analysis software.
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Overlay Options

There are two methods for overlaying sample electropherogram traces in the 
Oligo Pro II data analysis software:
• Overlay multiple samples in the main screen 
• Overlay multiple samples in the Project Overlay screen; here the overlay of 

samples from different data sets is possible

Overlay Samples in the Main Screen

1 In the Plate map of the main screen, right-click successive sample wells from 
which you want to overlay the Electropherogram trace.

2 Use the slider bar of the Electropherogram trace to adjust overlap spacing 
(Figure 15). 

Figure 15 Overlay of multiple samples in the main screen

Plate map
Right-click the wells
to be overlaid

Slider bar
Adjusts the y-axis
overlap spacing
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Overlay Samples in the Project Overlay Screen

In the Project Overlay screen, you can overlay samples from a single or multiple 
data files. Load the file(s) in the Project Overlay screen, and select the samples 
from which you want to compare the Electropherogram trace.

After saving your changes in the project, you can also export the results, or 
generate a PDF report.
1 In the main screen, navigate to Project > Create Project.

The Project Overlay screen opens.
2 From the File menu, select Open File. 

Or select  from the toolbar.
3 In the file browser, select as many files as desired.

In the Project Overlay screen, a separate Plate map is displayed for each of the 
data files (Figure 16).

Figure 16 Overlay samples of multiple data files in the Project Overlay screen

4 In the Plate map(s), select the wells you want to overlay.
5 Use the slider bar to adjust the y-axis overlap spacing.
6 Use the slider bars in the upper right to adjust x-axis overlap spacing.

Plate maps
Select the wells to be
overlaid

Slider bar
Adjusts the y-axis
overlap spacing

Slider bar
Adjusts the x-axis
overlap spacing
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7 To save the data in the project, or start a new project, select the respective 
option from the File menu.

8 To create a PDF report, select  from the toolbar (the project must be saved 
in order to generate a PDF report).

9 To export the data, select from the toolbar (the project must be saved in 
order to export the data).

For more information about exporting data files, refer to Chapter 7, “Exporting 
Data from the Oligo Pro II Data Analysis Software”. For more information about 
generating a PDF, refer to Chapter 8, “Generating Reports from the Oligo Pro II 
Data Analysis Software”.
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6 Oligo Pro II  Data Analysis – View Capillary 
Positions

About View Capillary Positions 42
Open the View Capillary Positions Window 43
Manually Resetting Capillary Positions 47

This chapter briefly covers the tools and functions of the View Capillary Positions 
window.
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About View Capillary Positions

The Oligo Pro II data analysis software performs an automated capillary 
alignment procedure when reading in .raw data files generated by the Oligo Pro II  
instrument. This ensures that the capillary locations on the CCD detector 
selected for data analysis are of maximum absorbance intensity for providing the 
best possible signal to noise ratio.

View Capillary Positions is used to examine the capillary array alignment and the 
assigned locations used for data analysis. This option is typically not used in 
routine use since the locations are automatically assigned; it serves rather as a 
diagnostic/troubleshooting tool.
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Open the View Capillary Positions Window 

1 From the main screen of the Oligo Pro II data analysis software, select 
Analysis > View Capillary Positions. 

The View Capillary Positions window opens (Figure 17). Table 14 summarizes 
the available options in this window.

Figure 17 View Capillary Positions window

The View Capillary Positions window contains two sections:
• A plot of Capillary Positions (pixels) vs. Signal Distribution (intensity), which 

shows a summation of absorbance intensity for each capillary.
• The Capillary Positions table listing the pixel location for each of the 12, 24, or 

96 capillaries in the 12-capillary, 24-capillary, or 96-capillary array, 
respectively. 

In Figure 17, a proper alignment is shown where the red Current Positions 
symbols are centered on the peaks corresponding to each capillary. The 
algorithm automatically detects the peak locations and sets the capillary 
positions. If no absorbance is detected in a particular capillary, the algorithm will 
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fill the gap using the spacing between capillaries as a reference. In this way, the 
positions of all capillaries are indexed properly, even if no data was generated by 
some capillaries of the array.

During typical operation, no modifications should need to be made to the 
capillary positions. In rare occurrences, it may be necessary to adjust the 
positions slightly for one or two capillaries, or to manually adjust positions as 
described below. Table 14 provides information on how to change a location and 
save the changes. Only changes necessary to center the red Current Positions 
symbols on any misaligned capillaries should be performed, to avoid introducing 
artifacts into the data.

View Capillary Positions Window Settings

The table summarizes the settings of View Capillary Positions window. 

Table 14 View Capillary Positions window settings

Menu Item Description

Capillary Positions The Capillary Positions table lists the pixel locations used on the CCD detector 
used for data analysis. There are either 12, 24, or 96 cells, each corresponding to 
a capillary of the array. The table is labeled by row and well position. 

To view a particular capillary position, click the cell in the table, or click on a peak 
in the plot of Capillary Positions (Pixels) vs. Signal Distribution (Intensity) to view 
the corresponding assigned well. A red vertical cursor will be displayed on the 
plot to indicate the detector position.

Reset Performs the automatic alignment algorithm to set the capillary locations. Any 
manual changes made to the pixel positions will be overwritten. A blue threshold 
line will appear (Figure 18). This line can be moved up or down to select an 
appropriate threshold for automatically determining capillary location.

Method Two methods for determining capillary location can be used:
• Close Proximity (default): This setting will use the original instrument 

alignment file to determine where to locate the capillary positions, filling any 
gaps in signal as needed.

• Ignore Original: If the Close Proximity method fails to locate the correct 
capillary locations, this will attempt to assign capillary positions based on the 
signal positions; press Reset and use the threshold cursor and Peak Width 
settings to adjust assignments.
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Peak Width Provides a width threshold for selecting peaks in the plot of Capillary Positions 
(pixels) vs. Signal Distribution (intensity); a higher value selects wider peaks while 
a smaller value selects narrow peaks.
The recommended value is 3.

Undo To undo the last manual adjustment operation to the Capillary Positions table. 

Zoom Enables zooming in the x- and y-axis of the Capillary Positions (pixels) vs. Signal 
Distribution (intensity) plot. 
To zoom-in: Click the icon, and place the mouse over the plot. Click and drag it 
outward to expand a box area to define the zoom region. Release the mouse 
button to apply.

Autoscale To autoscale the plot of Capillary Positions (Pixels) vs. Signal Distribution 
(Intensity). 

Pan Enables panning (shifting) the plot of Capillary Positions (pixels) vs. Signal 
Distribution (intensity). Click the icon, and place the mouse over the plot. Click 
and drag the cursor to shift the current view. This is most often used in 
combination with the Zoom function.

Accept Accepts the current Capillary Positions table locations for the capillary array to 
use for data analysis and return to the main screen of the Oligo Pro II data 
analysis software.

Cancel Cancels any changes made to the Capillary Positions table locations for the 
capillary array, close the View Capillary Positions window and return to the main 
screen of the Oligo Pro II data analysis software.

Table 14 View Capillary Positions window settings

Menu Item Description
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Figure 18 View Capillary Positions window after clicking Reset. A blue horizontal cursor can be used to 
select the threshold for locating capillary positions.
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Manually Resetting Capillary Positions 

In very few situations, it may be necessary to manually relocate the capillary 
positions in the View Capillary Positions window. This is usually the result of a 
combination of the two following conditions:
• The instrument optical alignment (i.e., capillary positioning) is not set properly. 

When the set capillary locations are far from the actual locations, the Oligo 
Pro II data analysis software will have difficulty locating them automatically, 
especially for 96-capillary data. Therefore, is it very important to ensure the 
capillary array locations have been reset and properly aligned after changing a 
capillary array.

• A capillary within the array has no detectable absorbance signal, either due to 
no sample or marker being loaded into the particular sample well, or because 
the capillary is plugged.

Ensuring the capillary array is properly aligned will in most all cases enable 
automatic detection of capillary locations, even if some capillaries do not 
generate signal. In this event, it is necessary to manually adjust or reset a 
capillary location, the user should follow the steps outlined below.

Figure 19 shows the View Capillary Positions window for a file where a capillary 
signal is missing (118 pixels). As a result of a slight misalignment of the 
instrument optical alignment, the software has mistakenly assigned a capillary to 
pixel 495 (red circle) and not assigned a location to the second capillary from the 
right (red circle). In this instance, it is not possible to adjust the threshold to 
successfully select the proper capillaries. 
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Figure 19 View Capillary Positions window where capillary is not assigned properly (circled)

Figure 20 View Capillary Positions window showing misaligned capillary not reset by threshold

In Figure 20, it is shown that clicking Reset and using the threshold will not 
correctly reassign the capillaries due to the low signal from pixel 118.

To manually delete the improper capillary position, click the mouse over the 
location, and click [Delete] on the keyboard (Figure 21). 
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Figure 21 Manually deleting pixel 495 by selecting it and clicking [Delete] on the keyboard

Note that pixel 495 has now been removed from the Capillary Positions table and 
a blank cell is present in H12 (see Figure 22).

Figure 22 Alignment after manually deleting pixel 495
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Next, to manually add a location, click on the adjacent capillary location to where 
you wish to add the capillary, and press [Insert] on the keyboard. Click the 
keyboard arrows to move the newly added vertical red cursor to the desired 
location, in this case pixel 684 (Figure 23).

Once the proper positions have been adjusted, click Accept to accept the current 
Capillary Positions table locations for the capillary array and return to the main 
screen of the Oligo Pro II data analysis software. All subsequent data analysis will 
use the newly saved capillary locations.

Figure 23 Alignment after clicking the [Insert] key at the rightmost position and using the keyboard arrow 
to move the vertical cursor to pixel 684. Capillary positions are now correctly located. Click 
Accept to save.
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7 Exporting Data from the Oligo Pro II Data 
Analysis Software

Export Data 52
Open the Export Dialog 52
Examples of Exported Data 55

This chapter provides an overview of the options available for exporting 
processed data from the Oligo Pro II data analysis software. 
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Export Data

Once data is opened and processed within the Oligo Pro II data analysis software, 
in many cases it is desirable to output the measured/calculated information in 
common formats for storage in a common database or for use in other 
programs.

The Export dialog is used to export information from the Oligo Pro II data analysis 
software.

Open the Export Dialog

To export sample results from the Oligo Pro II data analysis software:
1 From the main screen, select .

The Export dialog opens (Figure 24).

Figure 24 Export Data dialog

Table 15 summarizes the available options in this dialog.
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Export Dialog Settings

Table 15 Export dialog settings

Menu Item Description

Sample Options Determines which samples of the data file will have information 
exported. There are two options: All samples (results for all 
samples of data file exported); and Selected samples. The 
Selected Samples option will open the Select Capillaries window 
(below). 

Select the respective wells, columns and/or rows of the sample 
plate, and click Save. To abort the selection of the samples, click 
Cancel.

Peak table – Standard or Alternate Standard: Exports the Peak table for all selected samples as a 
single .csv file, listed in order of the sample well (Figure 26).
Alternate: Exports the Peak table for all selected samples as a 
single .csv file, listed in rows (Figure 27).

To define the report items and their order, click . Make your 
entries in a separate dialog, and click Apply. Click Save, to save 
these settings for future use.

Electropherogram Image Exports the electropherograms in the image format specified 
(.bmp, .jpg, or .png). Click Show annotations to include 
annotations.

Purity table Exports the Purity table (Figure 28)
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Export File Path Determines the file path for saving exported data. The default 
directory is the same folder that contains the .raw data file 
(recommended). 
To select an alternative directory, click the folder icon. In the file 
browser menu, navigate to the desired directory.

Export Exports the data file according to the settings made.
In the dialog Export Complete, select Open Folder Now to open 
the directory. Click Close to close without opening the export 
folder.

Cancel Cancels the export operation and returns to the main screen of 
the Oligo Pro II data analysis software.

Table 15 Export dialog settings

Menu Item Description
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Examples of Exported Data

When exporting data from Oligo Pro II data analysis software, the exported files 
will be named by the .raw filename followed by an extension dependent upon the 
information exported (Table 16; Figure 25).

Figure 25 Exported data showing file name conventions

Table 16 Exported data naming conventions

Exported Item Description

Peak Table Filename Peak Table
Example: 2013 07 15 18H 29M Peak Table

Individual Electropherogram Gel Image Filename Well ID Sample Name
Example: 2013 07 15 18H 29M H1 SampH1

Purity Table Purity Calculation
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The following figures show examples of typical exported data formats: 
• Peak Table

Figure 26 Exported Peak Table - Standard file format
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Figure 27 Exported Peak Table - Alternate file format

• Purity Analysis

Figure 28 Purity Analysis
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8 Generating Reports from the Oligo Pro II Data 
Analysis Software

Generate Reports 59
Open the Generate PDF Dialog 59
Examples of Generated Reports 62

This chapter provides an overview of the options available for generating reports 
from the Oligo Pro II data analysis software.



8 Generating Reports from the Oligo Pro II Data Analysis Software
Generate Reports

59 Oligo Pro II Data Analysis Software User Manual

Generate Reports

The Oligo Pro II data analysis software can generate Adobe PDF formatted 
reports for convenient viewing of processed data, reporting detailed information 
for each sample analysis. 

Open the Generate PDF Dialog

1 From the main screen, select .

The Generate PDF dialog opens (Figure 29). 

Figure 29 Generate PDF dialog

Table 17 summarizes the available options in this dialog.
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Generate PDF Dialog Settings

Table 17 Generate PDF dialog settings

Menu Item Description

Sample Option Determines which samples of the data file will be included in the report. All 
selected samples will be saved in a single PDF report file; each sample will be 
printed on a separate page of the report.
There are two options: All samples (results for all samples of data file exported); 
and Selected samples. The Selected Samples option will open the Select 
Capillaries window.

Select the respective wells, columns and/or rows of the sample plate, and click 
Save. To cancel the selection of the samples, click Cancel.

Run summary A summary of run information is printed on the first page of the PDF report 
including Filename and Data Path; date Created; # of Capillaries; Array Serial # if 
entered; capillary Effective Length; Array Usage Count; Version # of software; 
Device Serial # (Figure 30).
If this is not selected, these fields will be blank.

Method detail Details of the experimental method of the Oligo Pro II instrument is printed on the 
first page of the PDF report.

Traces summary The Trace Summary page is printed with up to 12 electropherograms per page 
(Figure 31). Traces will show the Sample ID information for each trace.
If not selected, this field will be blank.
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Peak table For all selected samples, the Peak table is printed on each sample result page in 
the PDF report (Figure 32). If not selected, this field will be blank. 

To define the report items and their order, click . Make your entries in a separate 
dialog, and click Apply. Click Save, to save these settings for future use.

Electropherograms For all selected samples, the Electropherogram trace is printed on each sample 
result page in the PDF report. In the report, the peaks are annotated with the 
currently selected annotation. The x-axis scale is shown as displayed Oligo Pro II 
data analysis software at the time of printing (Figure 32).
If not selected, this field will be blank.

Show annotation Shows the annotation(s) made to the individual sample electropherograms.
If not selected, no annotation for samples will be shown.

Purity table Prints a Purity table (Figure 33).

Logo Allows to import a company logo at the top of the report (any image can be 
imported).

Generate PDF report Generates the configured report. In the file browser menu, navigate to the desired 
directory, and enter the desired report filename. The default directory is that 
containing the .raw data file.

In the Message dialog, click OK to open the report, or click Cancel to close 
without opening the report.

Cancel Cancels the report generation operation and returns the main screen of the 
software.

Table 17 Generate PDF dialog settings

Menu Item Description
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Examples of Generated Reports

Figure 30 through Figure 33 below show examples of the PDF report pages 
generated by the Oligo Pro II data analysis software. 

The header of each page displays the .raw data file name and the page number; 
the footer contains software version and copyright information as well the date 
and time of report generation.

Figure 30 Page 1 of PDF report (all fields shown; 12 samples were selected)
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Figure 31 Trace summary of PDF report (all fields shown; 12 samples were selected)
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Figure 32 Individual result page of a PDF report (all fields shown)
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Figure 33 Example Purity Analysis table in the PDF report
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